
 

 

General questions 
   

 

   

What do I need to start using BIMcollab? 

he BIMcollab web application runs on any modern web browser. You don't have to install anything, 

all you need is an internet connection. Our BCF Managers run inside your BIM application and 

therefore have the same system requirements as the BIM tool your are installing the BCF Manager 

for. Download BCF Manager > 

  

The stand-alone version of our BCF Manager is available for Windows 7 (32-bit and 64-bit) and 

later. 

   

 

 
I get too many mails, how can I change this? 

Via Settings > My settings you can define the email notifications for the active project. Choose if 

you want to receive emails for every change, once a day, weekly or never.  

 

     

 

 

If you are a project leader you have the additional possibility to choose to receive an overview of 

all activities in the active project (activity report) daily or weekly: 

 



 

 

Via Menu > My account you can switch the email notification for your BIMcollab space completely 

on or off. This overrules the settings for mail reports in all your projects. Important notifications 

about team member- or user-settings are always send. 

 

 

 

   

What roles are available within the BIMcollab environment? 

Roles define user rights that (dis)allow team members to perform actions on the server. There are 

two different roles on space-level:  

• User (general) 

• Administrator: can setup new users and projects, can define labels, types, priorities and user-

groups  

 

At project level a team member can have a role with specific rights for that project:  



• Project leader: can edit project settings, add/edit issues and create reports 

• Editor: can add/edit issues and create reports 

• Reviewer: can view and approve issues as well as place comments 

• Viewer: can only view issues and project settings 

 

Team members with the role Project leader, Editor or Reviewer can set to be:  

• Assignable: Yes/No 

Only Project Leaders and Editors can be assigned:  

• Allowed to import BCF files" Yes/No 

 

Assignable means that issues can be assigned to the team member. 

When you switch off Assignable then the team member can still access the project and edit issues 

(unless the team member is a viewer). 

When you 'Remove' a team member then he/she has no access to the project anymore. 

   

 

   

Are all team members allowed to resolve and close issues? 

Closing an issue is actually an approval of the resolution. By default this can only be done by 

project leaders and the creators of the issue. The project leader can change this via the 'Edit 

project' button on the top-right of the Settings page of the project. 

The following choices are available:   

• Everybody (project leaders and editors) 

• Project leaders only 

• Project leaders and creator of issue 

 

Resolving can only be done by Project leaders and Editors. 

 



       

   

 

   

Can I use my mobile's camera to add photos to BIMcollab? 

When your device has a camera you can directly shoot a photo during the creation or editing of an 

issue: select the button 'Browse' left from the viewpoint snapshot and your device will ask you to 

shoot a photo or select one from your collection. 

   

 

 
How can I add new team members to my project? 

Project settings like team members, milestones and area's can be found on the Settings page and 

can be edited only by the project leader(s). However project leaders can only add users which have 

been created in the space by an administrator. 

 

On join.bimcollab.com this works a bit differently: you can add users to your team by typing their 

email-address. If the user did not have an account yet, you can send him an invitation to join your 

project. 

 

Project settings like title, description, start- and end-date and who is allowed to close issues, can 

be edited via the 'Edit project' button on the top-right of the Settings page of the project. 

   

 

   



How can I create a new project on join.bimcollab.com? 

When you start to use BIMcollab you will have one active project where you are project leader. 

Underneath your projects on the Projects page you find a button 'New project'. You can have 1 

active project at the same tim, when you create a new project another project becomes inactive. 

   

 

   

I need a new project on a private space, how to do this? 

Only administrators can create new projects on a private BIMcollab space. If you don't have 

administrator rights then you have to ask you administrator to create a new project. See also 

the Administrator’s section. 

   

 

   

How can I  view the most recent changes? 

On the Projects page you can see the latest activities of every project. You can click on them to see 

the issue-details. 

 

Select ‘Goto activities' to list all activities in chronological order or in any order you desire by 

clicking the column title. You can set a filter for Assigned to, issue status, visibility and a specific 

Period.   

 

 

 

You can also enter this activities-page from the issue-list pages by selecting the 'Show activities' 

button: 

 

 

   

 



   

How can I make a backup of my project? 

The best way is to save the whole project including history to a PDF or XLS report with the report 

button on the issue-list pages. First set up a filter for the issues you want to export. Choose to 

include the history including change log to have all information. When exporting a PDF the active 

view on your screen is used (Title view/List view), what you see is what you get. 

 

 

   

What is the meaning of visibility and user groups? 

Each team member can be a member of one or more group(s). The groups need to be setup in 

BIMcollab by the administrator before they can be used. 

 

When creating or editing an issue the creator of the issue can set the visibility to himself only, to 

colleagues in his company, to project leaders or to a user group. In this last situation only team 

members in that user group can see the issue. The creator and the owner of an issue (to which the 

issue is assigned) can see the issue always. Team members which are not included in the visibility 

choice will never see the issue. 

 

The visibility setting of issues and user groups are not available on join.bimcollab.com. 

   

 

   

Is KUBUS planning to create apps for mobile devices? 

We are considering to develop these. For now you can access BIMcollab via your browser from any 

device (computer, tablet and smartphone). BIMcollab works fine on any smart phone, but can take 



a bit more zooming on the web pages.  

   

 

   

Can I upload IFC files? 

BIMcollab is not for sharing models (IFC files), but for communicating issues. Therefore you cannot 

upload any IFC files. 

   

 

How safe is my data? 

BIMcollab runs under SSL and all sensitive data is encrypted at rest in our databases. To keep your 

data available at all time we have a 99,9% uptime and make constant backups at our Tier 3++ 

and  ISO 9001, ISO 14001 and ISO 27001 certified datacentre. The Interconnect datacentre and its 

services in Dutch cities 's-Hertogenbosch and Eindhoven are built redundant for optimal uptime 

and are monitored 24-7. More information > 

  

 

 

How to import my issue list or list of users? 

Do you already have a list of issues and want to start with BIMcollab? Or do you have a spread 

sheet with team members? It is easy to import your list with Excel or Numbers. You can download 

an example template on our download page >   

• Download the template 

• Open de XLSX file  

• Insert your data in the right columns. Every row is an issue or user. 

• In Numbers choose Archive > Export to > .CSV 

• In Excel choose File > Save as > .CSV 

• Import this CSV file on the Import page of your project.  

 

By importing an issue list with CSV every issue is imported, because BIMcollab only recognizes 

issues by their GUID and there are no GUID’s in a CSV file. 

 

If you are missing something, or have a special XLS file you want to import, send it to us and we 

will help you out: support@bimcollab.com. 

 

NOTE:NOTE:NOTE:NOTE: ssues may not contain all the properties available in BIMcollab. By uploading the file on the 

import page you can define default properties to issues that are missing. For more detailed 

information please read ”How can I import a list of issues from Excel?" 



 

   

 

   

Why does my name contain question marks in BIMcollab? 

BIMcollab is designed to support most character sets. However when your BIMcollab administrator 

imports users from a file, if the encoding used in the source file is not recognised by BIMcollab 

then any special characters your name may contain are converted into a question mark. To fix this, 

simply log into BIMcollab, select My Account from the menu and then edit your name. See also 

“Can I import user names using special characters?” in the For Administrators section. 

  



Starting with issues 
Below you will find a step-by-step instruction on how to create issues either manually or by 

importing a BCF file in the BIMcollab web application. 

   

Creating an issue from a web browser 

 

Step 1: Start your web browser on any device including mobile devices. 

Step 2: Log into your private space or use your account on join.bimcollab.com. 

Step 3: Select the project you wish to work on. 

Step 4: Click on the ‘New issue’ button. 

 

You will now enter a page similar to the one below.  

• In the light blue are you can change the issue’s properties. 

• In the dark blue area you can add a new comment and/or image to the issue. 

 

When adding an image to an issue when on a mobile device you will be prompted to take a picture 

or to choose one from a picture library. Both options can be very useful when creating issues while 

on a construction site. 

 

 

   

Importing an existing BCF(zip) file into your project 



Step 1: Start your web browser on any device including mobile devices 

Step 2: Log into your private space or use your account on join.bimcollab.com 

Step 3: Select the project you wish to work on 

Step 4: Go to the Import page 

Step 5: Click on the ‘Browse’ and select the BCFzip file you wish to import 

Step 6: Click on the ‘Import’ button 

 

 

 

The BCFzip file will now be uploaded and the issues it contains will be added to your project.  

• The issues to be imported may not contain all of the properties available in BIMcollab. In the 

Import panel you can define the default property values to add to the imported issues. 

• At the bottom of the Import page you can find the import history which contains a record of 

all imports which have been performed including when it was imported, by whom and how 

many issues it contained. 

• By default only project leaders can import issues. Editors can be given this right on a per-user 

basis. Viewers and reviewers cannot import BCFzip files. 

• A sample BCFzip file can be downloaded from here > 

   

Approving users 

An external BCF file can contain (multiple) assigned users who are not yet members of your team 

or are not recognized at all. This will cause the import function to automatically add these users to 

your team as ‘Pending’ users to ensure that all assignments remain intact. In the team member list 

you can:  



• Accept the new user by completing the user’s details and adding him/her to the team. 

• Mapping the unknown user to one of your existing team members and replace all references 

to this user to the chosen existing user. 

 

About issues 
 

 

 

   

How can I classify  statuses are available for an issue? 

One should start by defining the issue’s Type, Area and Labels.  

• Type defines what kind of issue it is such as a Clash, a Fault or an Inquiry. 

• Area defines in which part of the project the issue is present. 

• This could be specific rooms, floors or sections. 

• Labels are often used to define under which discipline the issue resides although you are free 

to use them as you wish. 

 

The then issue’s status can be set to Active, Resolved or Closed. It is not possible to add a status 

or change any status names.  

• New issues always start out as Active. 

• Active issues can be edited and set to Resolved or Closed. 

• Resolved issues can be closed or reactivated. A resolved issue can also have its resolution be 

approved or rejected when required. 

• Closed issues can be reopened to become Active again.  

 

 

  

 

 

   



What does the color of an issue mean? 

An issue can have these colors:   

• Black: Active 

• Orange: Active and deadline is passed 

• Green: Resolved 

• Blue: Approved 

• Grey: Closed 

   

 

   

What do I need to know when creating or editing an issue? 

When you create a new issue or start editing an existing issue, you will enter a menu with an light- 

and dark blue section. The light blue area let you change the issue properties. In the dark blue 

area you can add a new comment and/or picture to the issue. For example, to explain the 

modification. When you resolve, close, reactivate or reopen an issue, you can also add a comment 

and/or a snapshot. 

 

The creator can set and edit the visibility. The deadline is by default set to the milestone's end-

date (shown in grey) but can be changed to what you want (shown in black). You can also notify 

other users of the current change. 

 

It is also possible to assign team members to the approval list to ask to have the resolution 

approved before being closed. 

 

Note:Note:Note:Note: The Browse-button on mobile devices with a camera let you to take a photo or browse your 

photo-library. Images or photo's added like this do not contain linked information to the model in 

BIM.  

 



 

 

 

   

Which issue properties are available and what do they mean? 

 

Title and description Title and description Title and description Title and description  

Always try to give a short title and a clear description to the issue for better understanding. 

 

Responsible team member or ownerResponsible team member or ownerResponsible team member or ownerResponsible team member or owner 

You can assign an issue to any of the team members who are ‘Assignable’ as defined by the 

project leader. 

 

Status of the issueStatus of the issueStatus of the issueStatus of the issue 

In BIMcollab we have a strict workflow regarding the status of an issue: Active -> Resolved -> 

Approved -> Closed. A resolved issue can also be reactivated and a closed issue can be reopened. 

The settings of the project define who are allowed to close issues. The color of an issue shows the 

status of the issue. 

 

 

  

  

Classify the issueClassify the issueClassify the issueClassify the issue 

Select Type, Area and Labels from predefined lists to classify the issue. You can also filter by these 



properties in the issue lists or when exporting. The project leader can define areas. The 

administrator defines types and labels. 

 

Schedule the resolutionSchedule the resolutionSchedule the resolutionSchedule the resolution 

With Priority, Milestone and Deadline you can schedule the issue. A milestone can contain an end 

date as set up by the project leader. That end date appears in grey as deadline for the issue when 

you select a milestone. But you can change the deadline for any individual issue, after the deadline 

appears in black. What can be done with milestones? 

 

Confidential issue and visibilityConfidential issue and visibilityConfidential issue and visibilityConfidential issue and visibility 

Issues are visible for all team members by default. The visibility-property allows you, as creator of 

the issue, to limit this only to yourself, your company or to a group of team members. Only project 

leaders can add team members to groups. 

Can issues be private/confidential or hidden for specific users?  

 

Notify more useNotify more useNotify more useNotify more usersrsrsrs 

The team member who has been assigned an issue will receive a notification of all modifications to 

the issue (if he didn’t switch notifications off). You can add the team members you also want to 

notify of a certain modification. They only get a notification of this change. 

 

Viewpoints (only in BCF Managers, BIMcollab can only add “images”)Viewpoints (only in BCF Managers, BIMcollab can only add “images”)Viewpoints (only in BCF Managers, BIMcollab can only add “images”)Viewpoints (only in BCF Managers, BIMcollab can only add “images”) 

A viewpoint can contain a snapshot of the problem, a list of ID’s of involved/selected objects, 

selected/highlighted colors and a camera position. When you create issues in a BIM tool which 

supports BIMcollab or BCF files then these are added automatically. When you select an image via 

the Browse button or take a photo to add to the issue, there is no link to the BIM model. 

 

Having the resolution approvedHaving the resolution approvedHaving the resolution approvedHaving the resolution approved 

When creating issues which involves multiple participants/disciplines you may want your solution 

to be approved by one or several other team members. By adding team members to the approval 

list you can have the approval process started once the issue is set to resolve. 

   

 

   

Can I add references to other issues? 

Yes, you can add hyperlinks to other issues in your comments. To do so first type a ‘#’ followed by 

the issue number. As you type, the title of the issue you are referencing to will be displayed. 

 



 

   

 

   

What can be done with Milestones? 

Milestones can be added, changed or deleted by Project Leaders in the Project Settings section. 

Define the milestones for the project by giving them a name, start-date and end date. A milestone 

is assignable by default, which means users can assign issues to that milestone. Switch off 

‘Assignable' for past milestones, so users can't assign issues to it anymore. 

 

A milestone can contain an end date as set up by the project leader. That end date appears in grey 

as a deadline for the issue when you select a milestone. But you can set a deadline for any 

individual issue, after the deadline appears in black. 

 

 

   

 

   

What can be done with Areas? 

Areas can be added, changed or deleted by Project Leaders in the Project Settings section. Areas 

can be used for geometrical areas in a construction project like foundation, roof or left-wing, top-

floor, etc.  

 

When creating a new Area in a project, it is possible to define an “area owner”. When defined, any 

issue classified to be part of that area will automatically be assigned to that area’s owner. 

 



 

   

 

   

Can I change Types? 

Only the administrator can add, edit or delete Types. This can be done in the Administrators 

General section. On join.bimcollab.com you cannot add or change types. 

 

  

   

 

   

Can I change Priorities? 

There are five priorities by default, which the administrator can edit. This can be done in the 

Administrators General section. On join.bimcollab.com you cannot change the priorities. 

   

 

   

Can I change Labels? 

Only the administrator can add, edit or delete Labels. This can be done in the Administrators 

General section. On join.bimcollab.com you cannot add or change labels. 

   

 

   

Can I change Groups? 

Groups can be defined to represent groups of people who are part of the same department, 

company or organization.  

 



Team members can be assigned to one or more groups. With the visibility-property you can make 

an issue only visible to a specific group. Only the administrator can add, edit or delete Groups. 

This can be done in the Administrators General section. Groups can be used for visibility on issue 

level.  On join.bimcollab.com you cannot add or change groups. 

  

 

 

   

Can issues be private/confidential or hidden for specific users? 

New issues are visible for all team member by default. With the visibility-property you can make 

the issue only visible to yourself, your company or a specified group of team members. Only 

administrators can define a group, and project leaders can add team members to it. 

 

Groups and visibility options are not available on join.bimcollab.com 

 

Note: be careful with which team members you share project-reports when using confidential 

issues. When creating a project or activities report you have the option to exclude items which are 

not visible to all. 

   

 

   

Why is an issue I still need to approve already closed?  

The approval process does not overrule other’s ability to close an issue. Therefore it is possible to 

close an issue which has not received all of it’s approvals. To see who closed the issue, check the 

issue’s history. 

   

 

   

Why are returned issues no longer assigned to me? 

Since the 'assigned to' option is a part of the BCF 2.0 file format which the KUBUS BCF Managers 

support it might be possible that your partner's software isn't. If other parties use software that 

only supports BCF file format 1.0, only the Author is added. 

   

 

   

What's the difference between 'author' and 'assigned to'? 

The assigned to user is the one you make responsible for the issue. The author is the one creating, 

editing or commenting an issue. 

When creating a new issue or comment, your username is automatically used as author. When 

connected to BIMcollab this is always the name you used for login. Only team members defined in 



the BIMcollab project are available to assign issues to. 

 

Notes: When working on BCF files you can change this username via Settings. In BCF 1.0 files the 

assigned-to property is not supported. 

   

 

   

Can I delete an existing issue? 

No, BIMcollab keeps track of all issues and every change that is made to provide a full audit trail. 

That's why it is not possible for any user or admin to delete existing issues or changes made to 

these issues. After issues are resolved you can close them to keep a clear overview. 

   

 

   

Is it possible to assign issues to multiple users? 

No, you can only assign one user who is responsible for the issue. But it is possible to notify 

multiple team members about the issue. With issue management it is really important to assign 

your issue to the right person. By assigning multiple people, nobody takes responsibility. 

 

It is possible to have an issue’s resolution approved by other team members such as a supervisor 

or the client  prior to being closed by adding them to the approval list. 

    

 

   

Can I import an issue list? 

Yes, you can import a BCFzip file or an Excel / Numbers / Google Sheets file. When you already 

have a file for a running project and want to join BIMcollab, simply import the issue list via the 

Import page.  

 

For a more extensive explanation please see: How can I import a list of issues > 

   

 

   

Can I import multiple issue lists at once?  

Yes, you can select multiple files at once to be imported. BIMcollab will queue them automatically. 

  



Optimal Workflow 
Follow the following steps to optimize your issue management workflow with Solibri Model 

Checker and BIMcollab. 

 

Step 1: Load your IFC models 

Create a federated model of your project by loading the IFC models from the various disciplines 

 

Step 2: Perform Tests 

Select the tests that you wish to perform and run them. 

   

1. Load your IFC models 

 

 

2. Perform tests 

 

 

 

Step 3: Create Slides 

Evaluate the test results and create slides for those issues which need to be resolved 

 

Step 4: Create Presentation 

Create a new presentation based on the test results. 

 



 

 

 

Step 5: Sync with BIMcollab 

Synchronize your results to BIMcollab by exporting new and changed issues 

 

      

 

Step 6: Sync Again 

Synchronize your results from BIMcollab by importing changed issues 

 

Now that your issues have been uploaded in BIMcollab and are fully synchronized with Solibri they 

can be managed and worked on by your team. You will then want to confirm that the issues have 

indeed been resolved. 

 



Step 7: Update your models 

Before you synchronize with BIMcollab again always make sure that you always have the latest 

models loaded into Solibri. Note that it is important that you update the models and do not 

replace them as this will sever the links between the models and the issues. 

 

Step 8: Sync with BIMcollab 

Continue to use the same presentation (do not delete it) and synchronise your results from 

BIMcollab by importing changed issues. 

 

Step 9: Re-Run your tests in Solibri 

This will evaluate if the current issues have been resolved. If new issues are found you can create 

slides for them as well. 

 

Step 10: Update your Presentation 

Again using the same presentation perform an ‘Update Presentation from Results’ 

 

Your issues have now been updated and are ready to be synchronized with BIMcollab. To do so go 

back to Step 5 and keep repeating this cycle until all your issues have been resolved.  

  



BCF Managers 
   

 

   

How do I activate my BCF Manager? 

With our BCF Managers you can add BCF capabilities to your BIM software for free. You only need 

to register yourself and request an activation key. There are two ways to get an activation key:  

• You receive an activation key automatically after being registered on a BIMcollab space or on 

join.bimcollab.com. 

• You can request an activation key from our website. 

 

 

 

When you start the BCF Manager for the first time, it will ask you to activate your license. Click on 

'Get activation key' if you do not have an activation key. Click on ’Activate license’ and enter your 

personal activation key: 

 

 

 

Your BCF Manager is now ready for use and you can connect with your projects on the space you 

were invited to or on join.bimcollab.com. 

 

Note: You can always lookup your activation key: login to BIMcollab and open the Getting started 

section by clicking on your name. There you will find your personal activation key at the bottom of 

the page. 

   



 

   

How do I connect the BCF Manager to BIMcollab? 

To set up a connection, click on the BIMcollab logo in the toolbar. 

 

 

 

You need an account on a BIMcollab space (you can be invited by a project leader or create your 

own free account on join.bimcollab.com to make a connection. Type the address of the space you 

want to connect to, give your credentials (the same as on the website) and choose the 'Connect' 

button.  

 

An account can also be created by someone who has a BIMcollab server for which you are invited 

to collaborate. The administrator of this server can create an account and provide the credentials 

for you to login. 

 

Note: If you can't connect to the server your network settings may cause problems. The BCF 

Manager can solve this automatically in most cases. If this doesn’t work, you will need to fill in the 

proxy server settings manually in the Settings dialog > 

 

 

 

IssueIssueIssueIssue    filterfilterfilterfilter 

For a better overview, you have the possibility to filter out closed issues, or issues not assigned to 

you. By default only the active and resolved issues are shown. The less issues that are visible the 

faster you are set to go.  

 



 

 

Save connectioSave connectioSave connectioSave connectionnnn 

If you save the connection, BCF Manager remembers your filter for future connections. Also you 

can select the connection from the dropdown right from the BIMcollab button for fast access.  

   

 

   

The BCF Manager license server is not responding; how to proceed? 

For the registration process (one-time action) there has to be an internet-connection. If this 

connection is somehow blocked this message will appear. In most cases a proxy server is blocking 

traffic to the license server. The BCF Manager can solve this automatically in most cases. If this 

doesn’t work, you will need to fill in the proxy server settings manually in the Settings dialog > 

 

Tip: If you do not have access to the proxy server information, try using a different network for the 

registration. 

   

 

   

Will KUBUS develop BCF Managers for more BIM platforms? 

We are working on connecting BIMcollab to more BIM applications, but we can't specify these yet. 

We are cooperating with BIM software developers who are using our API to build a connection, like 

Solibri did. 

 

If you want your BIM vendor to connect to BIMcollab send them this link: Developer page. Or send 

your request to support@bimcollab.com. 

  

 

 

   



Which settings are available? 

Via the Settings button in the toolbar you can open this 

Settings dialog. 

 

Email addressEmail addressEmail addressEmail address 

The email address is only used as your author name in the offline mode (when loading BCF files). 

If you use the online mode (connected to BIMcollab), the author name of the logged in user is used 

for all modifications.  

 

Proxy serverProxy serverProxy serverProxy server 

In some cases, a proxy server in your network unintentionally blocks the BCF Manager activation. 

In most cases this is automatically detected but if this in not the case, the proxy server data can be 

entered manually in the settings page. You may have to ask your IT department for assistance. 

   

 

   

Which settings are available for Revit? 

The following settings are available for Revit users. 

 



 

 

Stay in orthographic modeStay in orthographic modeStay in orthographic modeStay in orthographic mode 

Selecting this option will force Revit to stay in orthographic mode when zooming to an issue. 

 

View name extensionView name extensionView name extensionView name extension 

The view name extension will be added to the name of the view created by the BCF Manager. This 

will allow multiple users to open views in BIMcollab when simultaneously working on the same 

shared model. 

   

 

   

Which settings are available for ARCHICAD? 

The following settings are available for ARCHICAD users. 

 



 

 

Viewmode for 3D zoomViewmode for 3D zoomViewmode for 3D zoomViewmode for 3D zoom----totototo 

By setting the default Viewmode, you will override the current setting in the 3D view for a zoom-

to. The choice 'From active view' keeps the viewmode in the 3D window. 

   

 

   

Which settings are available for Tekla? 

The following settings are available for Tekla users. 

 

 

 

Keep Keep Keep Keep projection modeprojection modeprojection modeprojection mode 

Selecting this option will force Tekla to stay in its current projection mode when zooming to an 

issue. 

    



 

   

Can I start a project on BIMcollab from the BCF Manager? 

No, it is not possible to create a project from the BCF Managers. Log in to your BIMcollab space to 

start a new project and add team members. After that is done you can connect to the project from 

the BCF Managers.  

  

 

   

Can I publish issues which I created offline or which were loaded from a BCF 
file? 

No, the BCF Manager works either offline (load and save BCF files) or online (connected to 

BIMcollab). 

 

If you want to save issues created offline to a BIMcollab project you should save the issues to a BCF 

file and import that BCF file into the BIMcollab project via the web application. Login, select the 

project and go to the Import page. 

  

 

   

How do I create or edit an issue? 

Select the + button to create a new issue. Select the 'Edit' button to edit an existing issue.  

 

 



      

 

This will bring up the issue dialog box below. Here you can set or change the issue properties. A 

title is mandatory, optionally add description and a comment or viewpoint to explain the problem 

and the reason for assigning.  

 

 

 

The BIM modeling application adds a 3D viewpoint to the issue that contains the following:  

• Camera (in perspective or isometric depending on your current view) 

• Components linked to show (select: visible or selected or non = show all) 

• Selected objects (if checkbox checked) 

• Clipping planes 



 

Note: For Tekla Structures the option to link the visible components is not available. To link 

components, first select them in the 3D view and choose; viewpoint > selected. 

 

When creating a 2D issue from a floor plan, elevation or section, there are no components linked 

to an issue. 2D Viewpoints only can be zoomed-to in the application they were made in. 

 

Linked componentsLinked componentsLinked componentsLinked components 

When communicating by BCF, there is a practical limitation in linking components to an issue. 

Linking more than 25.000 components to one view can seriously affect the use of BCF.  

 

TipsTipsTipsTips 

For a practical workflow: it is not necessary to select objects for every issue to be effective.  

Use the function: none = shows whole model option, optionally combined with cutting planes, to 

create lightweight informative issues. 

 

 

 

Viewpoint informationViewpoint informationViewpoint informationViewpoint information 

Once an issue is created, information that is linked to a viewpoint can be viewed by clicking on the 

‘I’ button near the view image. 

 

     

 

 

StatusStatusStatusStatus 

An issue can be set to a different status by choosing the 'Resolve', 'Close' or 'Resolve and close' 

buttons. This will automatically save the changes as well. BIMcollab has a strict workflow regarding 

the status of an issue: Active -> Resolved -> Closed. 

 

ModificationsModificationsModificationsModifications 

Every modification to an issue will be saved to the BIMcollab database. Changes made with the BCF 

Managers will only become available for others after the issues are synchronized with BIMcollab. 

   

 

   

What issue properties can I add/modify in the BCF Manager? 



The BCF Managers can edit all issue properties the same way as in the Web application of 

BIMcollab. See the section Issues for FAQ about the possibility with issues. 

 

Note that  Milestone and Area are not available when working in offline mode with the BCF 

Managers, as these are not supported by BCF. 

   

 

   

How do I create or edit a BCFzip file using the BCF Manager? 

The BCF Managers can be used to synchronize issues directly to BIMcollab or to create, open, edit 

and save BCF files. 

 

 

 

NewNewNewNew 

To start a new BCFzip file, click on the NEW button in the toolbar of the BCF Manager. You are now 

in offline mode and issues made can only be saved as BCFzip files. 

 

OpenOpenOpenOpen 

To edit an existing BCF file, use the OPEN button. With the dropdown arrow, recently opened 

BCFzips file are accessible. 

 

SaveSaveSaveSave 

To save your new or edited BCF file, click on the save button and choose the correct BCF version 

you want to save to.  

   

 

   

Can I use a BCF Manager in multiple projects at the same time? 

You can only work on one project at the same time with an instance of the BCF Manager. Close and 

publish (or save) the project you are working on before opening another one. If you can start the 

native application twice then you can also load the BCF Manager twice. Use the 'Save connections' 

option in the Connect-dialog to switch between projects easy. 

   

 

   

Why is the snapshot empty when I create issues in Revit 2014? 



There is a known bug in Revit 2014 that possibly can prevent saving an image from the 3D view. 

To fix this bug, the Revit installation needs to be repaired. Contact your Revit reseller for more 

detailed instructions about installation repair. 

   

 

   

Why won't the default user change in ARCHICAD? 

The default user in a project is initialized when you open a BCF file. When you change the default 

user in Settings, it is used next time you open a BCF file. 

   

 

   

Why isn't the BCF Manager opening in my saved work environment in 
ARCHICAD? 

Currently, the BCF Manager cannot start automatically in a saved work environment. However, the 

location and size of the dialog are saved. You need to activate the BCF Manager from the menu 

manually to open it on the same location as before. 

  



BCF Connector Solibri 
   

 

   

How can I connect to BIMcollab from Solibri Model Checker? 

In order to create a connection to BIMcollab from Solibri you need to install a free extension: BCF 

Connector. Download this from the Solibri Solution Centre after it has been assigned to you. 

   

 

   

How can I publish my existing Solibri presentation to BIMcollab? 

If you sync an existing SMC presentation with BIMcollab then you may encounter some limitations 

of the BCF connector. 

 

The best way to publish an existing Solibri presentation to BIMcollab is to first:  

• Create a new project in BIMcollab 

• Create a report in Solibri of the presentation in BCF format. 

• Import the BCF file into BIMcollab. 

 

Once the BCF file has been correctly imported into BIMcollab then you can continue to synchronize 

your project via the BCF Connector. 

Detailed step by step instructions can be found here > 

   

 

   

How do I keep issues synchronized between Solibri & BIMcollab? 

It is important that when you start working on issues in Solibri that you make sure you are always 

working with the latest data. It is therefore best that prior to making any changes you first update 

your IFC models and then import your data from BIMcollab to Solibri. 

 

After you are done with editing issues in Solibri, publish your changes to BIMcollab via the 

synchronize button. Select one of the ‘Export to server’ options. 

 

Together with this step we recommend that you import your changes from BIMcollab to Solibri 

again to make sure that any changes possibly made in BIMcollab in the meantime will be merged 

with your changes in Solibri. This can be done by selecting both ‘Import from server’ options in 

the synchronize dialog. 

   



 

   

Why are viewpoint components missing after an import? 

When issues are imported, Solibri builds a new viewpoint internally. Any components referred to 

from the viewpoint which are not present in the currently loaded models will be discarded. This 

can be the case when you are not using the latest models. 

 

Please make sure that you always have the latest models loaded before importing new or changed 

issues. Updating the models after the import will not resolve this issue. You will need to discard 

your presentation and import the issues again. 

   

 

   

Why are issue-nrs in Solibri and BIMcollab not corresponding? 

Solibri uses two numbers for issues in a presentations:  

• The number left of the snapshot is a serial number in the presentation. 

• The number top-left in the snapshot is called a Tracking ID which is a serial number of all the 

issues created in a Solibri file. 

 

BIMcollab generates its own serial numbers for issues, based on the order they are created, 

published or imported. Since issues can be made from several sources at the same time BIMcollab 

has to be leading in defining the issue-nr. Unfortunately Solibri does not synchronize issue 

numbers from BIMcollab like our BCF Managers are doing, and keeps it own serial numbers. 

 

Note:Note:Note:Note: when you create a new presentation in Solibri from BIMcollab the serial-nr of the issues in 

Solibri will be the same as the issue-nr in BIMcollab. But when you create new issues in Solibri and 

synchronize to BIMcollab the numbering can become different again if in the mean time issues 

where created on BIMcollab. 

 

Solibri development is aware of this problem and is working on a solution. 

   

 

   

After importing a BCFzip file or synchronization to BIMcollab I get empty 
snapshots 

In most cases this is caused by a comment in an issue without a viewpoint. While this is allowed in 

the BCF 2.0 standard, Solibri needs all comments to be linked to a viewpoint/slide. From 

BIMcollab® 2 this won't happen anymore by adding the most recent viewpoint to a new comment 

by default. 



 

The current Solibri implementation of the BCF 2.0 import however generates an extra (empty) slide 

for comments not linked to a viewpoint. Until this is solved you can prevent this from happening 

by adding a snapshot/viewpoint to a comment in other applications. 

 

Solibri development is aware of this problem and is working on a solution.  

   

 

   

Why is issue-status in Solibri changed after synchronization to BIMcollab? 

There are only 3 status types possible in BIMcollab and our BCF Managers: Active, Resolved and 

Closed. As a default Solibri uses: Open, Assigned, Resolved and Closed but users can add any 

status they want. We are not in favor of that approach because it conflicts with strict issue 

management. 

 

Each status that is not recognized by BIMcollab as being Resolved or Closed is translated to 

Active. For the best workflow between Solibri and BIMcollab, we recommend using only these 3 

statuses: Active, Resolved and Closed. 

   

 

   

Can I add new team members in BIMcollab via Solibri? 

New users cannot be added from Solibri. Any new users must be added to BIMcollab first by your 

administrator and then added as team member to the project by a project leader. 

   

 

   

Why are all modifications on my name after publishing a Solibri presentation? 

The built in BCF Connector in Solibri will assume that any issues found in your presentation which 

are not found in BIMcollab are new and will therefore create a new issue in BIMcollab under your 

name, since you are logged into BIMcollab. 

 

To avoid this please read “How can I publish my existing Solibri presentation to BIMcollab?” 

   

 

   

Why do I still see old team member names in Solibri? 

When you choose to export new or changed issues to BIMcollab, the user names will be converted 

to known team member names in BIMcollab. These changes will not be visible in Solibri until you 

import them from BIMcollab. We therefore recommend that when exporting new or changed issues 



that you also import changed issues as well. 

 

In some cases the old unconverted user names will remain in the selection list after 

synchronization. Please close and then re-open your model to refresh the list. 

   

 

   

Why are my Issue’s slides in the wrong order? 

In Solibri 9.7, if you create an issue with multiple slides then after synchronizing with BIMcollab 

you may see that the order of the slides has changed. 

 

This was a known issue prior to Solibri version 9.7.5. We recommend that you always install the 

latest maintenance release for Solibri. 

   

 

   

How can I speed up importing and exporting issues? 

The latest BCF Connector (1.0.40) has been optimized to synchronize issues between SMC and 

BIMcollab as quickly as possible by only transferring the changed data. We recommend that you 

always use the latest connector. 

 

However when importing new issues, SMC will need to create new issues and add these to your 

presentation. This can take a significant amount of time when importing a large number of new 

issues. 

 

We recommend that you regularly synchronize your presentation and, when possible, avoid 

importing large numbers of issues in a single go. 

 

TIP! Import new issues to separate presentations using the Area or Label filters to create smaller 

presentations which can be synchronized faster. 

   

 

   

Why was my issue data overwritten by SMC? 

When exporting changes, only the changed data is exported. However SMC is not able to 

recognize any changes made to the issue in BIMcollab prior to synchronization and these changes 

are therefore overwritten. 

 

We recommend that:  

• You always import the latest data from BIMcollab before making any changes in Solibri. 



• You export any changes made to an issue in Solibri immediately to BIMcollab. 

 

Should I use SMC or BIMcollab to import issues?Should I use SMC or BIMcollab to import issues?Should I use SMC or BIMcollab to import issues?Should I use SMC or BIMcollab to import issues? 

If you want to import issues from a BCF or CSV file then it is always recommended to import the 

issues into BIMcollab first and then import the new issues via the BCF connector into SMC. 

 

This workflow will ensure that all names, responsibilities and timestamps in the BCF or CSV will 

remain intact. Any new issues imported from Solibri to BIMcollab will have the current user set as 

‘creator' and the current date set as the ‘created’ date. The original creator and date will be lost. 

   

 

   

Why don’t I see selected/colored components in other BIM tools? 

Both colored and selected components in Solibri are stored by BIMcollab. However in Solibri it may 

not always be clear when a component is colored or selected.  

Some BIM tools are not able to handle colored and selected components in the same way as Solibri 

does. 

 

For more information read “Working with Colored, Selected and Highlighted Components in 

Solibri” 

   

 

   

Why can’t I connect to BIMcollab from the Solibri Model Viewer? 

Currently the Solibri Model Viewer does not support extensions like the BCF Connector and it 

doesn’t look like Solibri is going to change this soon. 

  



Viewpoints best practices 
   

 

   

The basics of a "good" viewpoint 

We mean ‘good' in the sense of understandable for others but also workable in the eco-system. 

Let’s start with the latter since you need to know some basics. The most important information in 

a viewpoint is:  

• Snapshot image 

• Camera position 

• Cutting planes (if any) 

• List of IFC GUIDs of visible/selected/colored components 

 

You will experience a dramatic slow-down of performance when synchronizing to BIMcollab when 

the list of IFC GUIDs become huge while working with big projects. Imagine a model of an office 

tower with more then 200.000 components. If they were all saved to a viewpoint this one 

viewpoint would contain more then 30Mb of data. Imagine having 30 of those viewpoints: they add 

up to 1Gb of data! 

 

Create lightCreate lightCreate lightCreate light----weighted viewpointsweighted viewpointsweighted viewpointsweighted viewpoints 

In our BCF managers we give you the choice which components in the 3D view will be linked to the 

viewpoint. That way you can easy limit the size. Additionally the BCF Manager will warn you if you 

are about to link >10.000 components. 

 

Note for Solibri usersNote for Solibri usersNote for Solibri usersNote for Solibri users 

When creating slides in Solibri it can easily happen that you link a huge nr of components to the 

viewpoint. If you notice a big slow-down in the communication between BIMcollab and Solibri, this 

is probably the cause. Check out the FAQ section about the best practices with viewpoints. 

 

Use cutting planesUse cutting planesUse cutting planesUse cutting planes 

When there are no components linked to a viewpoint it means that the whole model will be visible. 

Use this in your advantage by showing the whole model but cut parts away by cutting planes. 

Cutting planes are just some coordinates and thus small. 

 

It’s all about communicationIt’s all about communicationIt’s all about communicationIt’s all about communication 

Take in mind that the snapshot is also part of the communication and that a zoom-to does not 

have to show exactly what is on the snapshot. Think about it this way: create a 3D view with many 

components visible where only a few problematic components are highlighted. It could be enough 

to just link the highlighted (selected) components to the viewpoint: the modeler will understand 

from the snapshot and your comment what is expected from him, and he can use the zoom-to to 



lookup the problematic components. 

   

 

   

The camera position differs from the preview, how to proceed? 

If the difference is small this is caused by the fact that each BIM application uses its own camera 

system. When the difference is large this may be caused by differences in the origin in an IFC file 

in relation to the origin of your BIM project. 

 

Files in/from RevitFiles in/from RevitFiles in/from RevitFiles in/from Revit 

In Revit a user can set a custom origin in his project exported to IFC. If the survey point is moved 

from the startup location unclipped, this results in the survey as the origin of the IFC file. When 

creating a view by a receiving partner in other software the camera is positioned to this custom 

origin. When using this camera position in the Revit file, the Revit startup location is used (which is 

in this case not the same as in the exported IFC file). This will result in a wrong camera position. 

 

When working with IFC the startup location and survey are best kept at the same position. Correct 

the survey point and export new IFC files for collaboration. 

   

 

   

On zoom-to, I get a warning of more than 25.000 components 

Some applications using BCF can create viewpoints with extreme number of components. This can 

seriously effect the practical use of BCF and BIMcollab. For performance reasons we have added a 

warning when (too) many components are associated to a viewpoint. You can choose not to 

download and lookup the components which results in a fast zoom using only the camera 

position. 

   

 

   

When creating a viewpoint I get a warning of more than 10.000 components 

Viewpoints with thousands of components can be slow to publish, download and to lookup in the 

model. We advise you to limit the number of linked components in a viewpoint. For this reason you 

can choose to link visible components and/or selected components. Small viewpoints are 

lightweight and fast. To prevent you from creating large viewpoints by mistake we build in this 

warning. 

 

Important: when no components are linked to a viewpoint the the whole model is shown. In 

combination with the use of clipping planes you can create small viewpoints with good insight in 

the issue. 

   



 

   

Not all components in an issue are shown, how to proceed? 

This problem can have several causes. When components are not found at zoom-to, a button with 

red exclamation mark appears above the snapshot image. By clicking this you get an explanation. 

To identify more details of the source of this problem, view the information about linked 

components by clicking the information ('i') button above the snapshot image: 

 

 

 

A list of components appears which can be looked-up in the model by pressing the 'Check 

components' button'. 

 

Components are not foundComponents are not foundComponents are not foundComponents are not found 

The viewpoint contains components which are in a project-file which is not loaded or the 

components linked to the viewpoint are no longer in the project. Another explanation could be 

that the components are in linked files. See the next question how to deal with linked files in 

different BIM applications. 

 

Some components are found but still hiddenSome components are found but still hiddenSome components are found but still hiddenSome components are found but still hidden 

Components may be hidden by layer or project view settings. Change the visibility for these 

objects in your BIM application. 

   

 

 
How should I deal with linked (IFC) files? 

BCF issues use IFC identifiers that are written in every IFC component called GUID’s, which are 

unique. BCF stores these GUID’s in the viewpoint to select and show the corresponding 

components. ARCHICAD, Tekla and Revit all handle the linked IFC files different, depending on the 

application and version.  

 

When you use an IFC file as a link in ARCHICAD, Tekla or Revit, it depends on the application and 

the version how it handles these GUIDs. 

 

ARCHICADARCHICADARCHICADARCHICAD 

In ARCHICAD 18 and up, components in linked files are handled correct so it is possible to zoom 

to components in linked files. 

 

RevitRevitRevitRevit 

Components in Linked files in Revit will not be shown when zooming to an issue due to lack of 

support for this in the Revit API. We therefore recommend the following feature when using 



(multiple) links in a Revit file: Use the zoom to as usual, then use the ‘box visible elements’ 

function of the BCF Manager: 

 

 

 

This creates a section box, to make the context of the linked files clear for the issue. 

 

 

 

 

Tekla StructuresTekla StructuresTekla StructuresTekla Structures 

Only the components from the Tekla project can be made visible when zooming to an issue. Due 

to limitations in Tekla, the BCF Managers for Tekla do not have the ability to find components in 

linked files, nor can we offer a section box function to isolate components that are in IFC reference 

models.  

 

Solibri & simplebimSolibri & simplebimSolibri & simplebimSolibri & simplebim 

These applications only offer to load IFC files so the problem of linked files does not occur in 

these applications. 

   

 

   

How can I influence my 3D settings? 

View settings are not incorporated in the BCF file format. Your modeling software determines the 

way in which viewpoints are shown meaning the BCF Managers use the active view-settings on 

zoom-to. 

 

ARCHICADARCHICADARCHICADARCHICAD 

In the Settings-dialog of the BCF Managers for ARCHICAD you can set to zoom-to viewpoints 

always in shaded, hidden line or wireframe mode. If you choose ‘Current’ then the active view-

setting of the 3D window is used. 

 

RevitRevitRevitRevit 

In Revit you can influence the way the BCF Managers show viewpoints by the following method:  



• Create a VIEW TEMPLATE as part of the office template or running project. Name views exactly 

as written below. The BCF manager recognizes these names (case sensitive):  

o BCF Manager 3D - 3D views 

o BCF Manager PLA - 2D floor plans 

o BCF Manager CEI - 2D ceiling plans 

o BCF Manager S/E - 2D sections and elevations 

• The BCF Manager will show all views in Revit to zoom-to issues according to the 

corresponding VIEW TEMPLATE. 

    

 

   

How to use Survey Points in an open BIM workflow? 

When your Revit model contains a survey point then we recommend that you follow these 

guidelines to ensure a good open BIM workflow. 

 

Use the latest BCF Managers Use the latest BCF Managers Use the latest BCF Managers Use the latest BCF Managers  

In version 3 of our BCF Managers we included a number of significant improvements in how we 

deal with survey points. Please ensure that your team members are using the latest software 

release. 

 

Use Shared Coordinates when opening NavisworksUse Shared Coordinates when opening NavisworksUse Shared Coordinates when opening NavisworksUse Shared Coordinates when opening Navisworks 

When opening your Revit model in Navisworks, it is important that ‘Shared’ coordinates are used. 

This can be set in Navisworks under Options>File Readers>Revit. 

 

Include IFCSITE elevation when exporting to IFC Include IFCSITE elevation when exporting to IFC Include IFCSITE elevation when exporting to IFC Include IFCSITE elevation when exporting to IFC  

When exporting your Revit model to an IFC file, it is important that the ICFSITE elevation data is 

included in the exported file. 

This can be set in Revit in the “Export IFC” dialog under Modify Setup>Advanced. 

 

Hotlink your model in ARCHICAD 20 Hotlink your model in ARCHICAD 20 Hotlink your model in ARCHICAD 20 Hotlink your model in ARCHICAD 20  

When adding your model to an existing project in ARCHICAD 20, it is advised that you add the 

model as a hot linked module when possible. 

This can be done as follows:  

• Open the IFC first as a new project. 

• Save the file as an ARCHICAD Solo Project 

• Open the project you wish to add the model to 

• Select File>External Content>Place Hotlinked Module 

• Click “Choose Hotlink” and then “New Hotlink > from File” and select the saved model. 

 

For more information about Survey Points and ARCHICAD please this article on the Graphisoft 



Helpcenter > 

   

 

   

Why can't I see the components that I made visible in Tekla when I create an 
issue?  

In Tekla, it is currently not possible to automatically save visible components in an issue. The best 

way to achieve this is to first select the components that need to be visible before you create a 

new issue. 

   

 

   

Why are components that I added to an Issue in Tekla not found when the IFC 
is opened in another application?  

In Tekla, you can select an Assembly and link this object container to an Issue. This assembly has 

a different component ID than its subparts.When an exported IFC file from Tekla does not contain 

the Assembly references (due to the export’s setup), the BCF Manager will not find these 

components. 

 

Make sure to select an object within an assembly (subpart) before creating an issue. This way the 

component ID’s will match the ones found in an IFC file. 

   

 

   

Why does the BCF Manager report that some wall or slab elements are not 
found, although they are present in my ARCHICAD Model? 

When exporting an IFC file from ARCHICAD, a user can set an option to export a composite wall or 

slab as separate ‘building element parts’. This feature creates new subparts in the IFC file only, 

which are in reality, not present in the ARCHICAD source model. When these subparts are referred 

to in issues by other applications, the BCF Manager can’t select or show them as they do not exist 

in the ARCHICAD source model. Always make sure that issues only refer to the main wall or slab 

components and not their subparts. 

  



For project leaders 
   

 

   

Can I prevent users from closing issues? 

Yes, via project settings the project leader can use the setting 'Issues can be closed by' to define 

who is allowed to close issues. The options are: Everybody, Project leaders only or Project leaders 

and creator of issue: 

 

 

   

 

   

Can I prevent users from editing issues? 

Yes, a team member with the role of viewer can only view issues within the project, but can't edit 

anything. You can also give team members the role of reviewer. In this case they will be able to 

leave comments and approve issues when they are added to the approval list. They will not be able 

to edit the issue itself. 

   

 

   

Can I prevent users from importing BCF files? 

Yes, the project leader can switch the option ‘Allowed to import BCF files’ on or off for each team 

member separately. This can be set by clicking on a team member on the Settings page or by 

clicking on the checkboxes in the team member list. 

   



 

   

 

   

Can I prevent users from being assigned issues? 

Yes, the project leader can switch the option ‘Assignable’ on or off for each team member 

separately. This can be set by clicking on a team member on the Settings page. This can be set by 

clicking on a team member on the Settings page or by clicking on the checkboxes in the team 

member list.   

   

 

   

 

   

How can I add new team members? 

As project leader you can add team members to your project via Settings. But you can only add 

users that are present in your BIMcollab space. To add new users, you have to be administrator of 

the space. 

   

 

   



Can I undelete deleted team members, milestones or areas? 

On the Settings-pages which show list of team members, milestones or area's you can check the 

'Show deleted items' option to view deleted items. Those items will appear in grey and have a 

button Add or Undelete in the last column with which the item can be made available in the project 

again. 

 

Note: the 'assignable' functionality is automatically switched off for team members and milestones 

after undeleting. 

  

 

  

 

 

   

How can I import a list of issues from Excel? 

In some cases you may need to import a list of issues, from a source other than a BCF file, into 

BIMcollab. In that case the easiest way is to save your issue data into a CSV file. Creating a CSV file 

can be done using Microsoft Excel or any other spreadsheet applications such as Google Sheets or 

Numbers. 

 

Start by downloading one of our template files from the BIMcollab download page. You can now 

open the file using your preferred spreadsheet application and start entering the data. While 

entering your data you must follow the following rules:  

• Each row represents an individual issue. 

• Using the column names in the defined order is mandatory. 

• Additional columns appended to the list are ignored. 

• The column names are not case sensitive. 

• All cells should be formatted as TEXT cells. 

• All dates must be entered as dd-mm-yyyy or yyyy-mm-dd. 

• Leading zero’s are not mandatory so both 04-05-2016 and 4-5-2016 are valid entries. 



• Users need to be entered using their unique email address as defined in BIMcollab 

• The type, priority and status fields must correspond with those defined in your BIMcollab 

space 

• Any images URLs must refer to an image in JPEG, PNG, GIF or BMP format. 

 

Once all of the data is entered, you can now save the file as a CSV file.  

• In Excel choose File > Save as > .CSV 

• In Numbers choose Archive > Export to > .CSV 

• In Google Sheets choose File > Download As > .CSV 

 

You can now import the issue data by uploading the CSV file via the Import page in BIMcollab. You 

will also be able to define the default values to be used while importing the list. When importing 

issues via CSV there are a number of things one must be aware of:  

• Every issue imported will be added to the project as a new issue. It is not possible to update 

existing issues when using CSV files. 

• When a due date and a cause of delay are defined, a comment will be created on this due date 

containing the cause of delay. 

• When a modification date and a comment on modification are defined, a comment will be 

created on this modification date containing the comment. 

• Users in the list are mapped to existing users in BIMcollab based on email-address. 

• When a new user is found in the list then that user will be created in BIMcollab and added to 

the project. They will then need to be approved by the projectleader or the space 

administrator before they can log into BIMcollab and work on the project. 

• Microsoft Excel is not able to create CSV files using Unicode encoding. Therefore any special 

characters or non latin characters may be lost. 

 

If you are missing something, or have a special XLS file you want to import, send it to us and we 

will help you out: support@bimcollab.com. 

  



For administrators 
   

 

   

How can I manage my space?  

Administrators can reach the administration page by clicking on “Administration” in the pull down 

menu. From there you can reach the following administration pages. 

 

 

 

DashboardDashboardDashboardDashboard 

From here you can get an overview regarding you space including statistics (e.g. number of users, 

issues) and version numbers. You are also able to update your space’s logo from here. 

 

ProjectsProjectsProjectsProjects 

In projects you have an overview of all of the projects in your space. You can create new projects 

as well as edit current projects. 

 

UsersUsersUsersUsers 

The users page provides a list of all users in your space. Here you can add or import new users, 

approve pending users and edit a user’s properties. You can also define companies that users can 

be linked to. 

 

ReportsReportsReportsReports 

On this page you have access to any issue or activity report which was created in your space. From 

here you can download these reports as well as delete them. 

 

GeneralGeneralGeneralGeneral 

The general page will allow you to define settings and values which can be used in all projects 

including Types, Priorities, Labels and Groups. 

   

 

   

How can I add users or projects to my BIMcollab space? 

You can add and import users and projects to your BIMcollab space via the Administrator pages: 

Users and Projects. When you hit the active user/project limit, BIMcollab will notify you.  

For a more extensive explanation please see: How can I import a list of users > 

   



 

   

Can I delete a user or project? 

No, it is not possible to delete users or projects. Users and projects can however be set to 

inactive. Inactive users can no longer access BIMcollab and inactive projects can no longer be 

accessed. They can both be re-activated at any time.   

   

 

   

How can I activate/deactivate users? 

The quickest way is to go to Administration > Users and then click on the “Active” checkbox for 

each user you wish to activate/deactivate. 

You can also click on a user’s name, click on “Edit user” and then change the “active” setting.   

   

 

   

How many users can I have? 

n BIMcollab you can create an unlimited number of users but only a limited number of them can be 

set as “active” at any given time. The number of active users you are allowed to have, depends on 

your pricing plan. See the Pricing page for details. Additional active users can be added to your 

plan. Please contact us if you want to upgrade. 

   

 

   

Can I host BIMcollab on my own server? 

No. BIMcollab is provided as a web service only. If you have any concerns regarding safety, security 

or potential downtime then please visit our Data Center page. If you have any other concerns then 

please contact us so that we can work with you towards a solution.  

   

 

 
How do I upgrade my BIMcollab account? 

You can upgrade your plan or purchase extra users at our online store. If you have any questions 

about the process send an email to info@bimcollab.com 

   

 

   

How do I cancel my subscription? 



Send an email to info@bimcollab.com with the reason for cancelling your account. Note: When you 

cancel your account you cannot access your project data anymore. We advice you to backup your 

projects first by exporting the entire project as a report. 

   

 

   

Can I import user names using special characters? 

Yes you can. However you must take special care in how the file you wish to import is encoded. 

 

Most applications, including BIMcollab, use Unicode encoding to ensure that all special characters 

are supported and can be displayed correctly. However some applications, such as Microsoft Excel, 

do not use Unicode when exporting to a CSV file. The result is that the special characters will not 

recognized by BIMcollab when such a file is imported. Please consult your application’s 

documentation to ensure that the CSV is encoded in Unicode before importing. 

 

See also “Why does my name in BIMcollab contain question marks?” in the General section. 

   

 

   

How can I import a list of users?  

In some cases you may wish to import a list of users from another source into BIMcollab. In that 

case the easiest way is to save your user data into a CSV file. Creating a CSV file can be done using 

a spreadsheet application such as Microsoft Excel, Google Sheets or Numbers. 

 

Start by downloading one of our template files from the BIMcollab download page. You can now 

open the file using your preferred spreadsheet application and start entering the data. While 

entering your data you must follow the following rules:  

• Each row represents an individual user. 

• Using the column names in the defined order is mandatory. 

• Additional columns appended to the list are ignored. 

• The column names are not case sensitive. 

• All cells should be formatted as TEXT cells. 

 

Once all of the data is entered, you can now save the file as a CSV file.  

• In Numbers choose Archive > Export to > .CSV 

• In Excel choose File > Save as > .CSV 

• In Google Sheets choose File > Download As > .CSV 



 

You can now import the user data by uploading the CSV file via the Import users function which 

can be found in the Administration section of BIMcollab. 

 

When importing users via CSV there are a number of thing one must be aware of:  

• Users in the list are mapped to existing users in BIMcollab based on email address. 

• When a new user is found in the list then that user will be created in BIMcollab. They will then 

need to be set to active by the space administrator and added to projects before they can log 

in and use BIMcollab. 

• Microsoft Excel is not able to create CSV files using Unicode encoding. Therefore any special 

characters or non latin characters may be lost. 

 

If you are missing something, or have a special XLS file you want to import, send it to us and we 

will help you out: support@bimcollab.com. 

  



Moving issues from Solibri to a new BIMcollab project 
   

 

 

 

If you are using Solibri Model Checker and wish to move your existing presentations to a new 

BIMcollab project for the first time, then the following steps should be taken to transition your 

issue management from SMC to BIMcollab. 

   

Step 1: export your issues to a BCF file 

Start by opening Solibri Model Checker and then opening your SMC model.  

• Go to the Communication layout and select the presentation containing the issues you wish to 

manage in BIMcollab. 

• Check each slide to make sure all of the information is complete.  

• It is highly recommended that ‘responsibilities’ are assigned to only a single individual. 

• If an issue contains multiple slides, make sure that a comment is entered for each slide. 

Additional slides without comments will not be exported by SMC. 

 

You can now export your issues.  

• Go to the Communication layout and ensure the correct presentation is selected. 

• Click on the “Report” button. 

  

 

 

   

• Choose BCF Report v 2.0 as your report type and click “Save Report”. 

SMC will now export your issues to a BCF file and save it on your computer. 



 

 

   

Step 2a: Create a project on join.bimcollab.com 

If you have a STARTER account then:  

• Log into join.bimcollab.com  

• In the project overview screen click on “New project” 

• Complete the process as instructed. 

  

 

   

Step 2b: Create a project on your own BIMcollab space 

If you have your own BIMcollab space then:  

• Have your administrator log into your BIMcollab space. Only administrators can create new 

projects. 

• Hover the mouser cursor over your name and select “Administration” from the pull down 

menu to get to the administration area. 

• Click on the Projects tab and then on the “New Project” button. 

• Complete the process as instructed 

 

 

 

   

Step 3: Add new team members 



If needed you should add any new users to your space and make them team members of in your 

new project. 

   

Step 4: Import the BCF file 

Now that your new BIMcollab project has been created and the users have been added, it is ready 

to receive the exported issues from SMC.  

• In BIMcollab select the Projects menu 

• Select the new project by clicking on it’s name in the projects list. 

 

• Select the “Import” menu. 

• Click on the “Browse” button, select the BCF Report you exported from Solibri and the click on 

the “Import” button. 

 

 

 

   

Step 5: Approve new team members 

BIMcollab will import all issues from the exported report including all users. You must make sure 

that these users have been correctly added to your project as team members:  

• Click the “Settings”  menu.  

• You will now see a list of team members. 



 

When there are team members in the BCF report which were not yet in your BIMcollab project they 

will be created automatically by the import function. However they will be put on ‘Pending’ to be 

approved by a projectleader before they can work on the project. This how you need to do that: 

 

 

   

• Double click on a team member who is ‘pending’ to bring up the Approve team member 

dialog.If the user is new then please complete all the user information for that user. Otherwise 

you can map this user to one of the existing team members you added in step 3. 

• Repeat this until all of the users have been approved. 

 

Your project has been fully imported into BIMcollab and is ready for use.  

 

      

 

   

Step 6: Connect from Solibri to BIMcollab 

You must make sure that all of your issue-data remains synchronized when you continue to work 

with Solibri and BIMcollab. We advise you to follow this workflow when you plan to change issues 

in Solibri:  

• In Solibri go to the File layout and select Settings > BCF Connector 



• Ensure that your BIMcollab space is added to the list of BCF servers 

 

 

   

• Go to the Communication layout and ensure the correct presentation is selected. 

• Click on the “Synchronize” button: 

 

 

   

• Select your BIMcollab server from the list and then the project you just created. Click “OK”. 

• Select to import changes. This step will synchronize SMC with BIMcollab and ensure that the 

values used for ‘status’, ‘BCF status’ and user names are all properly mapped. 

• In “User Value Conversion” ensure that all SMC values are mapped to a BCF Server value. Click 

“OK”. 

 

You can now continue working on your SMC presentation. 

 



   

 

 

   

Step 7: How to remain synchronized 

As team members will be working on issues in both BIMcollab and Solibri, is is advised that you 

follow these steps to ensure that you are always working with up-to-date data and avoid 

unintentionally overwriting someone else work.  

• Before you start working in Solibri on issues make sure you have the latest data by 

synchronizing with BIMcollab first and import both new and changed issues. 



• When you finish working in Solibri, synchronize again to BIMcollab but now export both new 

and changed issues. 

 

As you proceed we also strongly recommend you follow also the following guidelines to ensure 

your data is always synchronized:  

• When updating models in SMC, always use the update function and never delete them. 

Otherwise your viewpoints will no longer be linked anymore to the components in the models. 

• When adding new test results to a Presentation, always update your presentation. Do not 

create a new one. 

• Always assign issues to a single individual. BIMcollab will only allow an issue to be assigned to 

a single team member to ensure a reliable issue handling and set clear responsibilities within 

the team. 

• Always add a comment to additional slides added to an issue. Slides without comments will 

not be exported by SMC. 

 


